AP Explore PT Prep

This short unit prepares students to complete the AP® Explore Performance Task (PT). Students will have learned the skills and concepts necessary to complete the task in previous units and will even have seen components of the task itself. This unit fully explains all components of the task and walks students through completing and submitting it.

Chapter 1: Explore PT Prep

Week 1

Lesson 1: Explore PT - Review the Task

This lesson contains a series of activities you can use to help students familiarize themselves with Explore Performance Task, how it is scored, and some example tasks provided by the College Board.

Lesson 2: Explore PT - Make a Plan

This lesson uses the Explore PT Survival Guide - Student Guide as the backbone for a series of activities to ramp up to doing the actual Explore PT. It contains some brainstorming activities around what qualifies as a "computing innovation" for the task as well practical advice and strategies for handling some of the nuances of the task such as distinguishing between a "harmful effect" and a "data security or privacy concern."

Week 2

Lesson 3: Explore PT - Complete the Task (8 hours)

Project

This lesson contains guidelines for teachers during administration of the Explore PT. It includes reminders about how you can interact with students while they are working on their projects, and suggestions about timeline. The Explore PT requires a minimum of 8 hours of class time. At the end, students will submit their computational artifact and written responses through their AP digital portfolio.

Chapter Commentary

Key Concepts and Pedagogy

Explore PT After Unit 4: Students are prepared to complete the Explore PT after Unit 4 of the course.

Highlight Ambiguities with Activities: It can be challenging to understand the expectations of the Explore PT and the way it is graded. This unit solves this problem through hands-on activities designed to bring these ambiguities to the surface. By grading sample projects or assessing potential project choices in a group setting, students are able to understand what is expected of them and ensure that their projects exceed this bar.
**Survival Guides:** The most significant resource in this unit are the Survival Guides created for each task. In addition to including activity guides for preparation activities, they include instructions for how students can identify good project choices and plan their allotted class time. Checklists for each task help students track their progress as they complete them.

**Practice Earlier in the Curriculum:** Students learn the skills and concepts necessary to complete the performance tasks through the curriculum. Each unit includes at least one practice PT or rapid research project specifically designed to prepare students for different elements of the tasks.
If you are interested in licensing Code.org materials for commercial purposes, contact us.
Lesson 1: Explore PT - Review the Task

Overview
This lesson contains a series of activities you can use to help students familiarize themselves with Explore Performance Task, how it is scored, and some example tasks provided by the College Board.

Students review the Submission Requirements and Scoring Guidelines for the Explore PT. Subsequently they review three example scored Explore PT submissions with commentary to better understand how the Submission Requirements and Scoring Guidelines are used together. In a wrap-up conversation they identify a piece of advice, a "gotcha", and a remaining question they have about the Explore PT.

Note: Most the exemplar task, scores, and commentary on scoring shared in this lesson come directly from the College Board. Code.org's commentary is noted where applicable.

Purpose
The Explore PT is in many ways straightforward: you perform research on a computing innovation and present your findings. As you dig into the details of the task, however, you quickly come across some of the nuances of individual components of the task and how they're scored. This lesson is designed to introduce what these nuances are, and begin to provide some answers to the questions that will inevitably arise. Keep in mind that the next lesson provides a more structured set of responses to those questions, and so today students are just diving in to what the task looks like.

Agenda
Getting Started (15 minutes)
- Introduce the Explore PT
- Review Explore PT Submission Requirements and Scoring Guidelines

Activity (45 mins)
- Explore PT Sample Response A
- Explore PT Annotated Sample A (score: 8/8)
- Explore PT Annotated Samples E (6/8) and H (4/8)
- Explore PT Annotated Sample J (1/8)

Wrap Up (5 mins)
- Explore PT: Advice, Gotchas, Questions
- Optional) AP Digital Portfolio Setup
  - Tech Setup - AP Digital Portfolio, Making PDFs, and Videos

Objectives
Students will be able to:
- Describe the major components of the Explore PT
- Describe how the Explore PT Scoring Guidelines will be used to assess the task
- Identify remaining questions about the Explore PT

Preparation
- Print or prepare to distribute digital copies of AP CSP Performance Task Directions for Students - Resource
- Briefly review all four of the graded sample Explore PTs included in the lesson plan
- Optional: While not provided to students, the documents below let you see how each written response was graded in all 10 sample submissions provided by the College Board. These may help you better understand expectations for each question and answer student questions.
  - Explore PT - Response 2a - All Samples - Resource
  - Explore PT - Response 2c - All Samples - Resource
  - Explore PT - Response 2d - All Samples - Resource

Links
Heads Up! Please make a copy of any documents you plan to share with students.

For the Teacher
- Explore PT - Response 2a - All Samples - Resource
- Explore PT - Response 2c - All Samples - Resource
- Explore PT - Response 2d - All Samples
For the Students

- AP Digital Portfolio Access - College Board Site
- AP Digital Portfolio Student Guide - Resource
- Explore - Computational Artifact: Sample A - Resource
- Explore - Written Response: Sample A - Resource
- Explore PT Annotated Sample E (6/8) - Resource
- Explore PT Annotated Sample H (4/8) - Resource
- Explore PT Annotated Sample J (1/8) - Resource
- Explore PT Annotated Sample A (8/8) - Resource
- AP CSP Performance Task Directions for Students - Resource
- Explore Performance Task - Scoring Guidelines 2019 - Resource
Teaching Guide

Getting Started (15 minutes)

Introduce the Explore PT

Remarks

Today we’re going to start looking more deeply at the Explore PT, focusing specifically on understanding:

- The different components of the Explore PT
- How the task will be scored

Don’t worry, you already have much of the knowledge and skills you need to do well on this task. The hardest part might be just understanding what is required of you.

First, we’ll quickly read the task description and look at some examples and how they were scored.

Review Explore PT Submission Requirements and Scoring Guidelines

Students can find links for all these activities in Code Studio. Here is what they can see:

Code Studio levels

- Levels
- 1

Student Instructions

Explore PT Prep – Reviewing the Task

Overview

This lesson contains a series of activities you can use to help students familiarize themselves with Explore Performance Task, how it is scored, and some example tasks provided by the College Board.

Lesson

- Review the Explore Performance Task.
- Review Sample Tasks and Scoring Guidelines.

Resources

College Board Documents

- AP CSP Performance Task Directions for Students - College Board Student Handout
- Explore Performance Task – Scoring Guidelines 2018 - College Board Doc

College Board Explore PT Samples
Teaching Tip

Understanding the Prompts: While not provided to students, the documents below let you see how each written response was graded in all 10 sample submissions provided by the College Board. These may help you better understand expectations for each question and answer student questions.

- Explore PT - Response 2a - All Samples - Resource
- Explore PT - Response 2c - All Samples - Resource
- Explore PT - Response 2d - All Samples - Resource

(annotated) Digital Portfolio Setup

- AP Digital Portfolio Student Guide - College Board Handout

Discuss: Students should each get printed or digital copies of the AP CSP Task Directions and the Scoring Guidelines.

- AP CSP Performance Task Directions for Students - Resource
- Explore Performance Task - Scoring Guidelines 2019 - Resource

Prompt: Read and then discuss with a partner (1) the “Submission Requirements” section on pages 5-6 of AP CSP Performance Task Directions for Students - Resource, and (2) the Explore Performance Task - Scoring Guidelines 2019 - Resource. For the scoring guidelines you can focus only on the first 3 columns for now: “Reporting Category”, “Task”, “Scoring Criteria”. We'll dive into the decision rules later. Just get familiar with these documents.

After reading discuss with a partner:

- What will you actually be turning in to the College Board?
- What are you hoping will become more clear after looking at example projects?

Discuss: Give students time to read the pages, in pairs or individually, and then discuss both questions with one another. The first one is more important for now.

Remarks

Hopefully in your reading you concluded that for the Explore PT you'll need to submit:

- A computational artifact (though you may be wondering what this means)
- Responses to a few written responses
- Citations to sources for these two items.

You should also have noticed:

- The Scoring Guidelines provide specific guidance on how each part of the task will be graded

I'm sure that right now you have a lot of questions about what this task will look like and how it will be scored. Before we answer them, let's look at some examples first.

Activity (45 mins)
Student Samples

The student samples used in this activity come directly from the AP Central website which shows in separate documents: student samples, scoring guidelines, and scoring notes. You can direct students there to find the samples, or look at others if you like.

Later in the activity we provide "annotated" versions that merge all three of these things together into one side-by-side view.

Discussion

Goal:

Students should understand from this example that the Scoring Guidelines are in many ways as important as the task description. The responses in this exemplar not only match the task description but address the particular "gotchas" of the scoring guidelines.

Students may still have questions about the individual prompts or scoring guidelines. Encourage them that you'll look at more examples which may help clarify.

Harmful effect v. Data security concern - this is one of the trickiest nuances of the task. We call it out here, but try not to dwell on it. In the next lesson an entire activity is devoted to unpacking this distinction.

Explore PT Sample Response A

Distribute: Provide pairs of students copies of Explore Sample A (links available on student page for this lesson).

- Explore - Computational Artifact: Sample A - Resource
- Explore - Written Response: Sample A - Resource

Prompt: This is a raw student submission - exactly what the student uploaded for their computational artifact and written responses. Read it first. Then with your partner spend a few minutes reviewing this exemplar. Be ready to share out the following answers.

- Did anything surprise you in looking at this exemplar?
- Do you think this scored well based on what you know about the scoring guidelines?

Discuss: Ask partners to spend a couple of minutes specifically discussing the prompts above. Then have the whole class quickly share the results of their discussion.

Explore PT Annotated Sample A (score: 8/8)

Remarks

This sample actually received a perfect 8/8 score. Let's look at the student response side-by-side with the scoring guidelines and the actual AP scorer's notes to see why.

Distribute: Provide pairs of students copies of the Annotated Explore PT Samples E and H (student links on code studio)

- Explore PT Annotated Sample A (8/8) - Resource

Prompt: With your partner look over this annotated version of the sample to see how each row of the scoring guidelines was applied. You should be reading specifically to answer any of the questions you had about the task earlier. After looking it over we will discuss:

- How does scorer differentiate between a harmful effect and a data security concern?
- What characteristics of this response made it score well?
- What questions do you still have about the Scoring Guidelines or Task description?

Discuss: Ask partners to spend a couple of minutes specifically discussing the prompts above. Then have the whole class share the results of their discussion.

Where possible call out ways that the discussion is answering questions raised earlier in the class about the Submission Requirements or Scoring Guidelines.

Difference between "harmful effect" and "data security concern"

- as called out in the scorer's notes, a "harmful effect" is one that comes from using the innovation as intended, which in this case is the use of a significant amount of energy. A good way to think of "harmful effect" is the unintended consequences of using the innovation as designed, which this response does.
- A data security concern often comes from misuse of the innovation, or using it in a way that was not originally intended. The effects or risks from spying, hacking, or even accidental exposure of sensitive information or invasions of privacy are common things listed here.
**Discussion**

**Goal:** Students should be gaining comfort with the structure of the task and scoring guidelines at this point. Since these tasks missed some points they provide a good opportunity to dive into those components of the scoring guidelines.

Here are some of the ways the samples fall short.

**Sample E:**
- the artifact fails to identify and effectively communicate the intended purpose, function, or effect of the computing innovation.
- the data used by the computing innovation is not fully defined along with an explanation of how that data is consumed (input), produced, or transformed (output).

**Sample H:**
- confuses the beneficial and harmful effects with the function of the computing innovation
- only describes data produced, not used, by the innovation

**Sample J:**
- fails to identify a computing innovation - this fact alone was the source of many lost points

Sample J should be used to kick off the wrap up conversation and prime the pump for tomorrow's lesson: how to pick a strong computing innovation. We also give tips to avoid getting tripped up as they respond to the prompts.

---

**Explore PT Annotated Sample J (1/8)**

**Distribute:** Provide students with copies of the Annotated Explore PT Sample J

**Prompt:** Now we'll look at a sample that scored one out of eight points. With your partner read through this sample and figure out why it scored so low.

**Discuss:** As a class, look at the sample and discuss the "gotcha" that this sample demonstrates. Once students discover and discuss the fact that this sample response fails to identify a computing innovation, and so misses all subsequent points, they are ready to move on.

---

**Wrap Up (5 mins)**

**Explore PT: Advice, Gotchas, Questions**

**Prompt:** Based on the examples that you saw today write down on separate post-its / scratch piece of paper
- The number one piece of advice you have for the Explore PT
- One "gotcha" to look out for
- One question you'd still like answered about the Explore PT

**Discuss:** Have students share their answers with a partner. Then have them place their responses on the board somewhere where they can be seen.
Once answers are on the board quickly report back to the group the patterns or trends that you’re seeing in their responses.

**Remarks**

Next time we meet we’re going to look more deeply into the Explore PT, using the three questions you just answered. To start we’ll be thinking about what’s probably the most important step in the whole process, picking your computing innovation in the first place. We’ll also talk about strategies for avoiding many of the “gotchas” you identified in this lesson. Finally, we’ll take time to address any remaining questions you have about the task.

**(Optional) AP Digital Portfolio Setup**

**Tech Setup - AP Digital Portfolio, Making PDFs, and Videos**

At some point students need to setup their AP Digital Portfolio to officially submit your performance tasks and to sign up for the exam.

Doing that setup and navigating around the digital portfolio will take a little bit of time.

The resource you need for that is primarily the: AP Digital Portfolio Student Guide - Resource. There are also several tools you should be familiar with in order to create the necessary PDF documents and Video screen captures that you need to submit. We provide links and some other instructions around tech-related things in the first level for this lesson.

**Code Studio levels**

- Levels
- 2

**Student Instructions**

**Tech Setup and Tools for the AP Performance Tasks**

**Background**

You need to setup your AP Digital Portfolio to officially submit your performance tasks and to sign up for the exam. There are also several tools you should be familiar with in order to create the necessary PDF documents and Video screen captures that you need to submit.

**Resources and Quick Links**

- AP Student Guide for setting up digital portfolio (PDF)
More Details -- Table of contents

- AP Digital Portfolio Setup (Create & Explore PT)
- Making PDFs for Written Responses (Create & Explore PT)
- Making PDF of Program Code (Create PT only)
- Making a Video Screen Capture (Create PT required, could also use for Explore PT computational artifact)

AP Digital Portfolio Setup

Goal: Students should be aware of the Digital Portfolio and how to access it. They should know what's there and be familiar with the basic mechanics of uploading and submitting their projects.

If your students have not done this yet, they will need to register themselves with AP digital portfolio in order to upload their projects.

Follow College Board Instructions to Setup Portfolio

- Here is the Student Guide for the digital portfolio. Follow these instructions to get setup.

The digital portfolio and guide contains a few helpful other things students should know about such as:

- Guidance about how to create a PDF
- Templates for the written prompts
- Ways to save drafts of written responses on the site and come back to it

Making PDFs for Written Responses

You are required to make a PDF of your written responses to prompts. It's recommended that you use the College Board templates for filling out your responses. At some point you will have your written responses in a word processing document such as Microsoft Word, Google Docs, or Pages.

What follows is copied from the AP Student Guide for the digital portfolio

How to make a PDF

- Recent versions of applications like: Word, PowerPoint, Pages, and Google Docs, have built-in features that allow you to save or export your file as a PDF. Instructions are provided below.
- If your software does not have a PDF option, visit the Adobe site and learn more about whether Acrobat from Adobe Systems can convert your document to PDF.
- You are responsible for ensuring that your file is properly formatted and readable. After you have created your PDF, be sure to check it by opening and reviewing your PDF in Adobe Reader, a free application that can be downloaded from the Adobe site.

Microsoft Office (Word, PowerPoint)

- In Word, Powerpoint, and other Microsoft Office programs you will "Save as PDF." Visit the Microsoft Office support page for more information about "Save as PDF." To save a Word or Powerpoint document as PDF:
  - Open your Word or Powerpoint document.
  - From the top menu select "File," and select "Save As."
  - In the dialog window, go to the drop-down menu for "Save as type," and select "PDF."
  - Click "Save."

Google Docs

- In Google Docs, you will "Download as" PDF. Visit the Google support page for more information on "Download a file."
To download a Google Doc as a PDF:

- Open your Google doc
  - From the top menu select "File," and select "Download as," and select "PDF Document (.pdf)"

Pages

- In Pages, you will "Export to" PDF. Visit the Apple support page for more information or follow the steps below:
  - Open your Pages document.
  - From the top menu select "File," and select "Export to," and select "PDF."
  - In the dialogue window select "Best," image quality.
  - Choose a destination for the export and click "Export."

Making PDF of Program Code (for the Create PT)

You need to make a PDF of your code and you also draw an oval and rectangle onto the PDF to highlight certain parts. There are a few options for this.

- Our recommendation: Use CodePrint - a tool for doing everything from the browser.
- Option 2: Make a PDF of the Code, then Edit the PDF using a PDF editor to draw shapes
- Option 3: Copy/Paste Code into a Word (or Google) document and add shapes there to produce PDF.

Details: how to make a pdf of your code

**Step 1** - copy your code in App Lab

- Switch App Lab into text mode
- Select all the code(highlight all with your mouse or Ctrl+A)
- Copy it (Edit -> Copy, or Ctrl+C)

**Step 2** - paste the code into a page or doc for printing

- If using CodePrint

  - This tool lets you draw rectangles and ovals over a pretty-ified version of the code (diagram at right)
  - If you can print a PDF from the browser, this should be all you need.

- Other options

  - **Option: Github Gist** -- GitHub Gist is a tool designed to let you quickly share code. We can use it to quickly print as well.
    - Go to GitHub Gist
    - Paste your code into the code area (the large open area with line numbers)
    - Optional: In the filename box type .js -- this forces the box to recognize the code as javascript
    - Click "Create Secret Gist" - this will save the code to a new page anonymously
    - From your Browser choose "File -> Print" and use your computer's option to print to PDF.

  - **Option: use a word processor Google docs or MS Word**

    - This option is fine but you won't get line numbers next to your code which can be convenient.
If you choose this option you should add your annotations (rectangle and circle) here in the word processor.

**How to add Ovals and Rectangles to a PDF**

If not using CodePrint you'll need to add ovals and rectangles to the PDF of your code.

**Windows**
- You need to install Adobe Acrobat (see the AP guide for students)
- Open the PDF in Acrobat and add annotations

**Mac**
- The built in Preview App allows you to add rectangles and ovals directly
- With PDF open in Preview go to Tools -> Annotate -> Rectangle for example.

---

**Making a Video Screen Capture**

Students are required to make at least one video that is a "Screen capture" of themselves using the program they wrote for the Create PT.

**How To Make a Screencast**

If you have not made any screencapture videos in class to this point students may ask how to do it. You will need to use screen capture software. Here are two good options.

- Online/Web: Screencast-o-matic (may require download depending on browser/plugins)
- Windows / Mac: Jing from Techsmith (requires download)

---

**Standards Alignment**

**Computer Science Principles**

- **1.1** - Creative development can be an essential process for creating computational artifacts.
- **1.2** - Computing enables people to use creative development processes to create computational artifacts for creative expression or to solve a problem.
- **7.5** - An investigative process is aided by effective organization and selection of resources. Appropriate technologies and tools facilitate the accessing of information and enable the ability to evaluate the credibility of sources.

If you are interested in licensing Code.org materials for commercial purposes, contact us.
Lesson 2: Explore PT - Make a Plan

Overview

This lesson uses the Explore PT Survival Guide - Student Guide as the backbone for a series of activities to ramp up to doing the actual Explore PT. It contains some brainstorming activities around what qualifies as a "computing innovation" for the task as well practical advice and strategies for handling some of the nuances of the task such as distinguishing between a "harmful effect" and a "data security or privacy concern."

The lesson concludes by providing students with resources to make a plan to complete the task starting in the next lesson.

Purpose

These activities are designed to approach reviewing the Explore Performance Task in a whole-class-discussion inquiry-based way. It's not required that you do this, but there is a fair amount of reading to get through and this should help break it up.

Agenda

Getting Started (5 mins)
Activity (45-60 mins)
  Introduce The Explore PT Survival Guide
  Picking a Good Computing Innovation (3 mins)
  Computing Innovation Brainstorm Activity (10 mins)
  Brainstorm: harmful effects v. data security concerns (10 mins)
  Rapid Research Activity - Harmful Effects (15 mins)
Wrap-up (10-15 Minutes)
  Making a plan

Objectives

Students will be able to:
- Describe the elements and purpose of the Explore PT
- Describe the scoring guidelines for the Explore PT
- Evaluate sample Explore PTs by applying the scoring guidelines

Preparation

- Decide whether you are going to print the Explore PT Survival Guide - Student Guide 2018/2019 - Student Guide - either in whole or in parts, or have students review and use the documents online.
- Reference the actual AP CSP Performance Task Directions for Students - Resource and Explore Performance Task - Scoring Guidelines 2019 - Resource if necessary.

Links

Heads Up! Please make a copy of any documents you plan to share with students.

For the Teacher
- Explore PT Survival Guide - KEY
  Make a Copy

For the Students
- Explore PT Planning Organizer - High Resolution PDF
  Make a Copy
- AP CSP Performance Task Directions for Students - Resource
Teaching Guide

Getting Started (5 mins)

Goal: The purpose of this discussion is to warm up students' brains and recall the elements of the Explore PT. We want students to start thinking about choices in light of what they have to do for the Explore PT, rather than simply out of interest or "coolness." Hopefully, the two go hand in hand.

In particular, we’ll look to drive home the point that your selection of a computing innovation should be done thoughtfully to make completing the task easier.

Discussion

Prompt: Based on our review of the Explore PT yesterday...

- What are the main things you have to do for the Explore PT?
- What should you do first?

Discuss: Let students call out the things they remember. Make this a quick review just to remind them of what was covered in the previous lesson.

A few of the things you need to do:

- Make computational artifact
- Provide written responses to prompts
- Research
- Cite everything with sources.

What should you do first?

- Pick a good computing innovation!

Activity (45-60 mins)

Introduce The Explore PT Survival Guide

Remarks

Today we will use the Explore PT Survival Guide to get started with the Explore PT. The beginning of the packet has a number of quick activities that help get us in the right mindset for thinking about and doing the task so you are ready to hit the ground running.

The guide will be helpful to you through the entire process of completing the actual Explore Task as well.


Read Overview (page 1): Have students read the Explore PT Overview section of page 1.

- The information about the task itself should not be news if you’ve already reviewed the Explore PT
- Focus on the suggested processes

Picking a Good Computing Innovation (3 mins)

Prompt: The Explore PT requires the selection of a computing innovation which includes a computer or program code (software) as an integral part of its functionality. Read the bottom of page 1: Picking a Good Computing Innovation. Based on what we learned yesterday looking at scored samples, and the criteria listed here, what are the characteristics of a computing innovation that make it a good choice for the Explore PT?

- Give students time to read
- Allow students to chat with a neighbor
- Highlight the 3 evaluation criteria for a computing innovation
- It is not necessary to do a whole group discussion here - this is just a kick off.

Transition: To get our brains moving we're going to look at a list of potential innovations or topics that someone might consider for the task.
Computing Innovation Brainstorm Activity (10 mins)

Do the activity page 2 of the survival guide

- With your partner pick the "three best" and "three worst" potential Explore PT topics from this list.
- As you do so keep in mind that you’re not picking your favorite topics, you’re picking the ones that are best suited for completing the Explore PT.
- Also start to jot down ideas for things you want to research yourself.

Give students 5 minutes to look at the list of innovations and start to jot down their own ideas.

Discuss and Review Have students somehow share and compare their lists. Afterwards lead a discussion based on the patterns you see. You’ll likely want to review the following points from the Survival Guide

- Not all technological innovations are computing innovations
- Focus or refine your choice so you’re choosing the “computing” part of your innovation
- Keep the written responses in mind. If you already have some sense of the data your innovation uses (think literal binary data) and the impacts of the innovation on society you’re probably on the right track.

Prompt: What other innovations did you think of while reviewing this list? Anything you’d be excited about researching?

- Allow students to call out a few of the ideas they had
- Encourage students to keep thinking about their own ideas for a computing innovation to use for the Explore PT as the go through the next activities.

Brainstorm: harmful effects v. data security concerns (10 mins)

Do the activity page 2 of the survival guide

- Read the definitions at the top of the page.
- Look at the list of “bad stuff” resulting from computing innovations. Which ones are harmful effects (by the definition in the Explore Task) and which are data security concerns?
- With a partner go through and mark each as either a harmful effect or data security/privacy concern.

Discuss: Have groups compare answer sheets to see if there are any disagreements.

- Most of the “answers” follow the definitions closely, but a few are nuanced.
- It’s a harmful effect if the “bad thing” affects a group of people resulting from the intended use of the innovation
- It’s a data security/privacy concern if the data is being used in ways that weren’t intended.

Rapid Research Activity - Harmful Effects (15 mins)

Goal: the goal here is gain clarity about the issue of the AP definition of a “harmful effect”. Hopefully, the list of scenarios helps draw the distinction. Students should exit the conversation with more confidence that if during their research they learn about “bad stuff” related to a computing innovation that they can make the distinction between a harmful effect and a data concern as far as the PT is concerned. Click image at right to expand.

Goal: The goal of this activity is NOT to come up with definitively correct or incorrect “answers” about the list of innovations. Many if not most technological innovations students come up with will be borderline cases that can be used for the Explore PT if framed the right way.

The purpose here is to spur discussion about what makes for a computing innovation not lead to frustration about what the “right” answers are.

Goal: Strong Choices all involve computer code or computing as a core part of their functionality, have broad societal impacts, and make use of data.

Goal: Good Choices might need a little finessing to make sure you identify a computational aspect to report on.

Goal: Poor Choices either do not themselves include a computer or program code and so are not computing innovations.

Some of these are vague or are combinations of computing and non-computing innovations, which could prove challenging later in your project. For example “email” may be hard to research. Focusing in on a specific computing part of these innovations would help. For example: Police body cameras and 3D printers are a strong choice so long as you focus on the system that actually stores and processes data rather than the hardware.
Goal: the biggest takeaway from this activity is that it can be very quick and easy to identify a harmful effect if using the right search terms and you can distinguish it from a data security/privacy concern. If it takes more than 10 minutes to find a harmful effect it's probably a sign you should pick a different computing innovation.

Discuss: What did you learn from doing rapid research? Is it easy or hard to find a harmful effect for a computing innovation.

- Have students compare with at least one other person in the class what they found.
- Partners should offer feedback about whether they think they’ve identified a “harmful effect” correctly.
- Highlight how quickly students were able to find articles about harmful effects. In a matter of minutes it’s likely most students landed on something useable for the Explore PT.

Wrap-up (10-15 Minutes)

Making a plan

- Turn to pages 5 and 6 of the survival guide
- The pages are there to help you plan for doing your own Explore PT.
- The Explore PT Planning Organizer is there as a place to take and categorize your notes and thoughts as you research your innovation.
- This Explore PT Planning Organizer - High Resolution PDF is a copy of what’s on page 5 and is better for print if you want to print it.
- The Explore PT Completion Timeline is there as a template for a daily guide for completing the PT.

Review pages 5 and 6 and add any initial notes or thoughts you have.
- Have students review the suggested timeline and make edits or updates to the schedule that will work for your school situation.
- NOTE the 8 hours is a minimum.

Prompt: taking into account all the activities we did today plus what you know about the Explore PT now, where do you expect you’ll be spending most of your time? For which parts of the task should you maximize your time?

Give students a moment to think and share ideas with a partner.

Discuss: Have students share where they think most of their time should go.
- Probably want to maximize writing and artifact creation time
- Research can be done rapidly
- Don’t forget to allocate time to proofread for easy-to-make mistakes that will cost points, like forgetting to cite sources.

Remarks

Now that we have methods and strategies for completing the task along with the beginnings of a plan, tomorrow we’ll start the task in earnest.

Standards Alignment
Computer Science Principles

1.1 - Creative development can be an essential process for creating computational artifacts.

1.2 - Computing enables people to use creative development processes to create computational artifacts for creative expression or to solve a problem.

7.5 - An investigative process is aided by effective organization and selection of resources. Appropriate technologies and tools facilitate the accessing of information and enable the ability to evaluate the credibility of sources.

If you are interested in licensing Code.org materials for commercial purposes, contact us.
Lesson 3: Explore PT - Complete the Task (8 hours)

Project

Overview

It is finally time for students to take on the Explore Performance Task. For a minimum of 8 class hours, students should work on their projects with only types of teacher support allowed (essentially: Advise on process, don’t influence or evaluate ideas).

The lesson includes reminders about how you can interact with students while they are working on their projects, and suggestions about time line. The Explore PT requires a minimum of 8 hours of class time. At the end, students will submit their computational artifact and written responses through their AP digital portfolio.

Purpose

There are no new CS concepts covered in this lesson. Students will individually work on the Explore Performance Task.

Agenda

Getting Started (20 mins)
- Ready?
  - Open AP CSP Performance Task Directions for Students - Resource
  - Read page 3: Preparing for the Through-Course Performance Tasks
  - Read page 7 & 2: Preparing for the Explore Performance Task & Policy on Plagiarism
  - Read Page 8 - Guidelines for Completing the Explore Performance Task Set

Activity (8 hours)
- GO! Complete Explore Performance Task
- Students submit completed Explore Performance Task

Optional: Review research practices and strategies

View on Code Studio

Objectives

Students will be able to:
- Complete and submit the Explore Performance Task

Preparation

- Forum
- Implementation Guidelines

Links

Heads Up! Please make a copy of any documents you plan to share with students.

For the Teacher
- Explore Performance Task Guidelines for Completing - Make a Copy

For the Students
- AP Digital Portfolio Access - College Board Site
- Explore Performance Task - Scoring Guidelines 2018 - College Board Doc
- AP CSP Performance Task Directions for Students - Resource
- Code.org Explore PT Template - Handout - Make a Copy
Teaching Guide

Getting Started (20 mins)

Ready?

Remarks

- For the next ~8 days, you will be completing the Explore Performance Task.
- All of the work for this task must be done independently.
- I (teacher) can help you with process and timeline and keep you on task.
- But from this point on, all ideas, and work are your own.

Before we start let's look at a few pages in AP CSP Performance Task Directions for Students - Resource.

Do these things:

Open AP CSP Performance Task Directions for Students - Resource

Read page 3: Preparing for the Through-Course Performance Tasks

This is a general checklist of things you should do to prepare for any of the AP Performance Tasks. Let's see how we did:

Prompt: With a partner - one person reading from the top down, the other reading from bottom up - check off things we've done to prepare so far. Identify anything we haven't done.

Quick chat with your partner to summarize anything new or unexpected you discovered.

- Some of the items do not pertain to the Explore PT so can be ignored.
- Everything else should have been covered in one way or another if you've done the prep lessons prior to this and used the Explore PT Survival guide.
- Address any questions students have

Read page 7 & 2: Preparing for the Explore Performance Task & Policy on Plagiarism

page 7 -- This is another checklist of things you should do to prepare specifically for the Explore Performance task. Again, let's see how we did:

Prompt: again divide and conquer - with a partner scan the page and check off things you feel confident about, and pull out things you're not sure about.

- Again most of the things on this list are things we've done in the previous preparation lessons.
- One gray area might be around this item:

If you would like more practice, see the optional activity at the bottom.

Page 2: Policy on Plagiarism

Prompt: While we're talking about citing sources, it's a good time to ask: According to the performance task
guidelines what constitutes plagiarism and what are the consequences? Look at Page 2 of AP CSP Performance Task Directions for Students - Resource

AP Computer Science Principles Policy on Plagiarism

A student who fails to acknowledge (i.e., through citation, through attribution, by reference, and/or through acknowledgment in a bibliographic entry) the source or author of any and all information or evidence taken from the work of someone else will receive a score of 0 on that performance task.

To the best of their ability, teachers will ensure that students understand ethical use and acknowledgment of the ideas and work of others as well as the consequences of plagiarism. The student’s individual voice should be clearly evident, and the ideas of others must be acknowledged, attributed, and/or cited. A computational artifact without acknowledgment of the media used in the creation of the computational artifact, and program code segment(s) written by someone else used in a program without appropriate acknowledgment, are all considered plagiarized work.

Make sure students understand what’s required in terms of citing sources. At the very least they probably want to keep track of links to articles they found during their research process so they can easily include them later on. Use the Survival Guide as a place to do this.

Read Page 8 - Guidelines for Completing the Explore Performance Task

This is a final list of Do's and Don'ts for the Explore PT.

Prompt: with your partner, read especially the "you may" and "you may not" sections of this page. Then with your partner summarize: what kinds of things can your teacher help you with?

• Let students read and discuss with partners
• Discuss specifically how you (teacher) are allowed to help and not. Short version: you can help students with the process of completing the task, you cannot help by evaluating their work or ideas in any way.
• There is some gray area around this item:
• as needed, seek assistance from your teacher or AP Coordinator in defining your focus and choice of topics; and

• This means the teacher can help you brainstorm ideas and talk you through making a good choice of topic, but cannot assign or suggest a particular one.
• The Innovation Brainstorm activity from Page 2 of the Explore PT survival guide fits this category.

Set

• Remind students of the overall timeline and that the official PT time is about to start
• Take out your Explore PT timeline that we developed.

Activity (8 hours)

GO! Complete Explore Performance Task

Links in Code Studio:

Students can find links to AP documents on the student page in code studio associated with this lesson.

Students may use the Code.org Explore PT Template - Handout to record their Written Response. Remind students that this must be exported as a PDF before uploading to the Digital Portfolio.

Code Studio levels

Explore PT - Complete the Task 1 (click tabs to see student view)
Wrap-up

Students submit completed Explore Performance Task

Submitting:
- At the designated end of the Task administration (having allowed for at least 8 hours of class time for work) students should submit their computational artifacts, and written responses to their AP Digital Portfolio.

Before they submit their final work:
- Encourage students to check over the rubric one more time to make sure they met the requirements.
- Make sure they have all the components necessary for the Explore Performance Task.

Optional: Review research practices and strategies

In working through these practice PTs, students have built skills with researching and talking about innovations and creating computational artifacts.

Goal: Review the skill of verifying sources. Refresh students memory of best practices for conducting research.

Remarks

One of the most important skills you’ll need in order to do well on the Explore Performance Task will be the ability to research a topic through high quality sources. Looking back at the research we’ve done in the previous units and thinking about what you’ve done in other classes, let’s compile a class-wide set of best practices for research.

Prompt

- "In your small groups create a list of best practices for research.”

Students should record what they did in earlier projects first, but may choose to look at outside resources to augment their lists.

Consider using this guide from Georgetown University about evaluating online content.

Discuss: Have groups report out to the whole room their lists of best practices for research.

- Student responses will vary but make sure to cover the following main areas
  - Author
  - Purpose
  - Objectivity
  - Accuracy
  - Reliability
  - Credibility

Standards Alignment

Computer Science Principles

- 1.2 - Computing enables people to use creative development processes to create computational artifacts for creative expression or to solve a
problem.

- **3.1** - People use computer programs to process information to gain insight and knowledge.
- **3.2** - Computing facilitates exploration and the discovery of connections in information.
- **3.3** - There are trade-offs when representing information as digital data.
- **3.4** - Computing enhances communication, interaction, and cognition.
- **3.5** - Computing enables innovation in nearly every field.
- **3.6** - Computing has a global affect -- both beneficial and harmful -- on people and society.
- **3.7** - Computing innovations influence and are influenced by the economic, social, and cultural contexts in which they are designed and used.
- **3.8** - An investigative process is aided by effective organization and selection of resources. Appropriate technologies and tools facilitate the accessing of information and enable the ability to evaluate the credibility of sources.

CSTA K-12 Computer Science Standards (2017)

- **IC** - Impacts of Computing

If you are interested in licensing Code.org materials for commercial purposes, **contact us**.